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Accessibility is essential for 10% of 
the population, necessary for 40% of 
the population and comfortable for 
100% of the population.

Presentation

The approval of the new Accessibility Code of Catalonia, in force 
since 1 March 2024, demonstrates a clear will of the autonomous 
region: to remove more barriers — of a physical, communicative 
and attitudinal nature — in order to guarantee equal opportunities 
for all and the non-discrimination of persons with disabilities.

The MICE (meetings, incentives, conferences and exhibitions) 
tourism sector strives to adhere to this important collective 
commitment. For this reason, the Catalunya Convention Bureau of 
the Catalan Tourist Board has decided to promote this publication, 
which is addressed to all stakeholders involved in the organisation 
of MICE events such as congresses, conferences, conventions, 
symposiums and general meetings.

The challenge of incorporating the principle of accessibility into 
events is a golden opportunity to help shape a more inclusive and 
friendly society which respects diversity and puts the individual at 
the heart of its decision-making. Making progress in this area will 
allow us to leave a legacy that brings added value to our activities. 
This publication sets out the path to follow and presents the tools 
we have at our disposal to take steps forward as a society. We’ll 
do it together, step by step.



How to easily navigate the 
document

Content and structure
• There are six chapters, each with different sections, which

briefly explain the ‘whats’ and the ‘whys’.

• The ‘hows’ are explained in the final and longest chapter,
called the Toolbox. There are 20 tools in total, each of
which functions as a standalone body of work.

Usability
• This is an accessible PDF.

• This means that it can be navigated with a screen reader
and keyboard, and isn’t limited to people who are able to
use a mouse.

• You can jump to any section or tool from the Contents page.

• The first six chapters also contain internal links to the
corresponding tools.

• Two of the tools (T4 and T5) are checklists. External links
are provided to these documents. They can be filled out
digitally, which removes the need to print them out as hard
copies.

• There are also external links to websites.

Important recomendation
When opening the document, be sure to activate the bookmarks 
on the left-hand side. These serve as a kind of contents page 
that allows you to easily navigate between the different chapters, 
sections and tools.
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1
What does making 
an event accessible 
entail?

7

Making a conference or event accessible entails:

• Removing physical, communicative and attitudinal
barriers

• Respecting diversity

• Contributing to inclusion

• Focus on the attendee to improve their experience

• Create an environment that is more comfortable and
convenient for everyone

• Provide exceptional added value

• Reinforce your corporate social responsibility (CSR)



1.1 
Definition of accessibility

According to Law 13/2014 on accessibility, this principle refers 
to the set of conditions that must be met by an environment 
(space, building, service, means of transport, product, etc.) so that 
everyone can enjoy it in a safe, comfortable and autonomous way.

Accessibility is a right of an event’s attendees 
and a legal obligation of its organisers.

1.2 
Key factors in an 
event’s accessibility

	O The diversity of attendees and the different ways in which 
they interact with their environment.

	O The barriers that could ruin an attendee’s participation in 
an event.

building

service

product

space

means of transport
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1.3 
The accessibility chain

It is helpful to think of accessibility as a chain.

You must do all you can to make sure that each link of the 
chain is accessible.

Make sure that all the links are well connected.

According to the UNE 170001 standard, the accessibility 
chain comprises reserved spaces, routes, transportation, 
location, signage, identification, technologies, building and 
communication.

The accessibility chain comprises:

Espacios reservados

Itinerarios

Transporte 

Localización

Señalización

Identificación 

tecnologías
 
Edificación 

Comunicación

	O

	O

	O

	O
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1.4 
Misconceptions about 
accessibility

	O “It exclusively concerns people with disabilities”: While it 
does concern them, it also concerns many people without 
disabilities.

	O “It is usually at odds with attractive design”: This 
document has been designed with accessible criteria, 
which disproves this claim straight away.

	O “It’s expensive”: The most essential accessibility measures 
are totally free, it’s just a case of planning for them.

	O “It concerns the provision of care and is not suitable for 
professional conferences”: On the contrary, attendee 
satisfaction will increase.
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Everyone has or has had some 
degree of disability (be it visible, 
invisible, permanent or temporary) 
at some point in their life.

1.5 
Examples of good practices

	O People facing linguistic and/or cultural barriers will 
appreciate clear signage and the use of pictograms.

	O People with food intolerances will appreciate information 
about allergens and gluten-free foods.

	O People who are obese will appreciate the provision of 
wider seats in the halls, in the restaurant and on the bus.

	O People with chemical sensitivities will appreciate the 
rooms not being scented with a strong-smelling air 
freshener.

	O People who are visually-impaired will appreciate the use 
of good chromatic contrasts and clear fonts on the event’s 
website.

	O People who use crutches will appreciate the existence of 
seats or ischial supports in the transit areas, at reception 
and next to the lift.

	O People with service dogs will appreciate you offering the 
dog a bowl of water.
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1.6 
Figures

1.3 billion people with disabilities around 
the world = 16% of the population = 1 in 6 
people according to the WHO (World Health 
Organization).

87 million people with disabilities in Europe 
according to the EU (European Union).

4.38 million people with disabilities in Spain 
according to the INE (Spanish Institute of 
Statistics).

1.10 million people with disabilities in 
Catalonia according to the ESCA (Catalan 
Health Survey).

According to the Disability Observatory, 
80% of disabilities are not congenital. 
Rather, they are acquired through illness 
or accident.
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1.7 
Symbols

Everyone recognises accessible toilets or parking spaces 
when they are marked with the wheelchair symbol. However, 
accessibility reaches far beyond the allocation of these spaces. 
As an organisation, you have a golden opportunity to highlight 
your commitment to inclusion. You should use the representative 
symbols of accessibility in all of your publications.

From the wheelchair to the universal 
access symbol

The symbol most typically associated 
with accessibility is that of a person 
in a wheelchair. This is known as the 
International Symbol of Access, or ISA.

There is an updated version of the symbol 
that represents a more autonomous 
wheelchair user in movement. The symbol 
represents Persons with Reduced Mobility, 
or PRMs. 

The three symbols shown below, meanwhile, represent visual, 
auditory and intellectual or psychic accessibility.

It is increasingly common to use a symbol 
that encompasses all accessibility needs. 
This universal symbol, which focuses more 
on the person rather than their physical or 
motor mobility, is most commonly used in 
digital environments.

This icon is inspired by the symbol 
proposed by the UN. It depicts a human 
body within a circle and represents global 
reach and equal access for all. It is an 
adaptation of Leonardo da Vinci’s “Vitruvian 
Man”.

For more information about accessibility symbols, go to the 
following tool:

T1 - Accessibility SymbolsT1
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2
Incorporating 
accessibility into 
planning

21

The best way to incorporate accessibility into the planning of a 
conference or event is by having the conviction and desire to do 
so. This is a non-negotiable starting point.

You can only take steps to improve people’s experience at your 
event if you are committed to making it accessible from the very 
beginning. This is particularly true for people with disabilities or 
specific needs. This will help us make progress as a society and 
leave a legacy that will last long into the future.



2.1 
Statement of Commitment

The first step of the planning phase is to state your commitment to 
holding an event that meets the legal accessibility guidelines and 
requirements.

How can I do this?

You can do it by including a statement along the following lines:

“We are committed to accessibility and inclusion”, “We want to 
ensure that our conference is free of barriers, be they physical, 
communicative or relational”, or “One of our goals is to make the 
event accessible, which we will achieve by taking into account 
diversity and the specific needs of everyone in attendance”.

You could display this statement or claim on the event website’s 
homepage, showing it as being ‘signed’ by the president of the 
convening body.

Alternatively, you could include it in the “About the event” 
or “Mission and values” section of the website. It is also 
recommended to mention this Statement of Commitment in the 
application dossier as an example of social responsibility.

2.2 
Naming an access officer

You must designate a member of the organising committee as 
the event’s access officer. Rather than focusing exclusively on 
accessibility, this individual will be given additional responsibilities 
to the ones they already have as part of the organising committee.

They don’t need to be an expert in accessibility. They must simply 
understand the content of this manual and apply it across all areas 
of the organisation. For specific queries or concerns, they are free 
to consult a specialist.

Given the transversal nature of accessibility, the main function of 
the access officer is to bring together all issues concerning this 
principle and ensure that the guidelines are implemented before, 
during and after the event.

On the following page you will find a table outlining the functions 
of the access officer that need to be appropriately delegated
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Functions of the access officer

Time Functions

BEFORE Statement of Commitment

Ask and identify the specific needs of 
speakers and attendees

Select an accessible venue

Assess the accessibility credentials of service 
providers

Anticipate and decide on the necessary 
technical measures and assistance

Contract additional services as required
Inform and train staff

DURING Check and monitor the implemented actions

AFTER Obtain feedback from speakers and 
participants

Assessment by the organising body

Accessibility report

2.3 
Importance of the 
registration form

The best way to identify the specific needs of participants, 
whether speakers or delegates, is via the event registration form.

The form received by participants must comply with digital 
accessibility guidelines. For more information, consult Chapter 5 
on Communication.

How can I do this?

	O Ask if the participant has any specific mobility, 
communication or dietary requirements.

	O Set an application deadline.

	O Provide the contact details of the access officer.

Jump to the tool:

T2 - Registration Form ModelT2
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3
Selecting 
the venue
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3.1 
Virtual events

Since the Covid-19 pandemic, the need for accessible video 
conferencing technologies has become more evident. Video 
conferencing platforms have adapted with this in mind. 

To choose the best platform for your event, you should consult the 
accessibility section of each platform’s website. These sections 
will provide a detailed explanation of what the measures are and 
how they can be used.

The accessibility requirements for virtual events can be broken 
down into three main areas:

1. The features of the platform

Make sure that the selected platform has all the features
required by the attendees, whether speakers or non-
speakers. This means, for example, that it must be
compatible with screen readers (audio systems used by
people who are blind) and offer subtitling services (for
people who do not speak the language fluently or have a
hearing impairment).

2. The content that is shared

Make sure that the format of the content shared during
the session is accessible. For example, the videos should
have subtitles and audio descriptions and the graphic and
legibility recommendations provided in the documents
must be taken into account.



You must also remember that anticipation is key. For 
this reason, it’s advisable to send the documents well in 
advance in an accessible format. This is because some 
participants will need to make their own adaptations prior 
to the session.

3. Commitment to accessibility
Not only does accessibility benefit everyone, but it is also a
legal obligation.

The accessibility challenges faced by persons with disabilities who 
attend or participate in virtual events will depend on these three 
factors.

Jump to the tool:

T3 - How to Make a Virtual Event AccessibleT3

3.2 
In-person events

Accessibility should be a determining factor when selecting a 
venue. For this reason, it is absolutely necessary to ascertain the 
full accessibility conditions of the event venue. This is true for 
several reasons:

	O To identify and communicate strengths.

	O To identify shortcomings and assess whether they can be 
resolved or if they make it impossible for the event to be 
fully accessible.

	O To guarantee the participation of Persons with Reduced 
Mobility or other specific needs.

It is recommended to visit the venue beforehand to check the 
characteristics and degree of accessibility in the following areas: 

	O External spaces and access points: means of transport 
and route to the entrance, car park and reception area.

	O Horizontal circulation inside the building: flooring, rest 
areas, signage of spaces and routes, lighting.

	O Vertical circulation between the different floors: lifts, stairs.

	O Public-access toilets

	O Meeting rooms

	O Relaxation space

	O Venue website

	O Restaurant and cafeteria

	O Staff

	O Emergency exits
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On this visit, it is recommended to carry a plan or map of the 
different spaces so that you can take notes on accessibility-
related matters. It is also recommended to document the visit by 
taking photos and videos.

Tool 4 includes a checklist with key questions that you should 
ask yourself when choosing an accessible venue. The aim 
of this questionnaire is to ask the recipient, with no jargon or 
technicalities, what makes a venue accessible. Alternatively, you 
could ask the venue’s managers to fill in the questionnaire.

Sometimes, venue managers believe that the building fulfils all the 
accessibility requirements when this is not the case. In this case, 
you can raise their awareness of any shortcomings so that they 
can address the issues and implement solutions.

When we are the owners of the venue (for example in the case of a 
Conference Hall), the checklist will serve as a good self-evaluation 
tool.

Importance of the Relaxation Space

The venue must have a designated room or area for resting, 
meditating, breastfeeding, or simply enjoying a moment of 
calmness and tranquillity. This space must be comfortable and 
sufficiently isolated from ambient noise. Silence must also be 
respected. The Relaxation Space may also be referred to as a 
Quiet Space, a Peaceful Space or a Calm Space.

Jump to the tool:

T4 - Venue Assessment ChecklistT4
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4
Selecting the 
complementary 
services

4.1 
Accommodation

Out of all the people who register to attend a conference, there 
may be some who require the accommodation to be adapted to 
their needs.

If accommodation reservation is one of the contracted services 
and the person has informed you of their needs and requirements 
in advance, you will need to find the most suitable room to make 
their stay as comfortable as possible.

Examples:

	O Obviously, wheelchair users will need accommodation 
that is completely barrier-free with a well-adapted 
bedroom and bathroom.

	O A person who is obese (and, therefore, classed as a 
person with reduced mobility) will require a bed with a firm, 
reinforced mattress. They will also need the different areas 
of the hotel to be close together so that they don’t need to 
walk far to get from the entrance to the room.

	O A person with achondroplasia, or a person of short 
stature, will appreciate an adapted room with low-level 
wardrobes and other fixtures.

	O A person who is blind does not require an adapted room. 
However, they will appreciate the room number being 
marked in Braille and being assigned a room that is close 
to the lift or stairs.
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	O A person who is deaf will appreciate the room having 
warning or notification lights (doorbell, intercom, 
emergency alarm, etc.).

	O A person with epilepsy travelling with their service dog 
will appreciate the hotel staff being trained on how to 
accommodate guests with epilepsy. In that case, they will 
request the guest to show the accreditation that grants 
their dog access to the hotel.

Jump to the tool: 

T5 - Accessible Accommodation Assessment 
Checklist

T5



4.2 
Transportation

Although most attendees will arrange their own transportation 
to the host city, some people may require transport-related 
assistance before and during the event. T2 - Registration Form 
Model is the best tool for establishing communication, as it has a 
section that asks specifically about mobility needs.

In order to be clear about the transportation arrangements that 
you can provide, you must collect information about public 
transport services, reserved parking spaces and adapted 
transport.

You must also ensure that the route to the entrance is accessible 
in terms of distance, width, flooring, lighting and general facilities, 
particularly for users of wheelchairs or mobility scooters.

	O Public transport

Cities with good public transport services are not always 
accessible. You will need to evaluate the available options 
in order to inform participants of their accessibility or make 
alternative arrangements. The first part of the T4 - Venue 
Assessment Checklist concerns local transportation. Once 
you’ve selected the venue, you’ll need to compile detailed 
information on “How to get there”.

	O Accessible parking spaces

Some Persons with Reduced Mobility (PRMs) may wish 
to travel to the event in their own vehicle. In this case, 
they will require accessible parking spaces that facilitate 
smooth transfer from the vehicle to the wheelchair and 
vice versa.

	O Adapted taxi or vehicle

Public transport is not always accessible to everyone. 
As such, you should compile information on adapted 
taxi services and ascertain whether they’re suitable for 
commuting to/from the venue or for transporting the 
attendee as part of an activity. You’ll also need to ascertain 
whether the service can be used by the person for private 
purposes.

	O Adapted buses and minibuses

Several things need to be considered in order to provide a 
discretional adapted bus or minibus service. For example, 
you’ll need to check that the transfer areas are wide 
enough and suitable for wheelchair users.

As for the vehicles, you’ll need to speak to the service 
provider to ensure that they meet the requirements of the 
wheelchair user.
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	O Wheelchair and mobility scooter rental

Some venues provide a wheelchair loan service. However, 
use is sometimes restricted to the venue’s premises. 
You will therefore need to compile information about 
wheelchair and mobility scooter rental companies before 
the event. There are many of these companies around. 
Furthermore, wheelchairs and mobility scooters can 
sometimes be rented from pharmacies and orthopaedic 
aids shops.

	O Service dogs

Users of service dogs are entitled to use any form of 
transport, so long as they carry the official permit and the 
animal is duly identified with a badge. The driver’s refusal 
to let them use their means of transportation is illegal and 
reportable behaviour.

Jump to the tool:

T6 - Transport RequirementsT6

4.3 
Catering services

Restaurants, hotels, convention centres, banquet venues and 
other businesses offer a wide variety of catering services. The 
accessibility of these services must be taken into account when 
planning the event.

As with other topics that refer to accessibility, T2 - Registration 
Form Model is a helpful tool for asking attendees about their 
dietary needs, allergies and intolerances. You must also remember 
to ask speakers, presenters, volunteers and other members of 
staff.

Some attendees may have to eat outside of the established meal 
times. These may include people with diabetes, pregnant women 
or those who have to take medication. You must assign a space 
that is suitable for these people to eat. One such example could 
be the Relaxation Space.

In general, the following must be taken into account: circulation 
space, seats, tables, menu, assistance, allergies, intolerances, 
dietary requirements and buffets.

Jump to the tool:

T7 - Catering RequirementsT7
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4.4 
Accessibility resources

There are a series of resources that serve to remove 
communication barriers, which are those that prevent or hinder 
access to information.

You will have to incorporate these complementary services if you 
want your event or conference to be truly inclusive and accessible.
But why? Because they add value and allow the message to reach 
a much higher number of people than you might think.

Each of these accessibility resources has its own tool detailing 
what it is, what it is for, who it benefits and how it is implemented.

With the exception of the sign language interpretation service — 
which should be offered on demand if signing deaf people are in 
attendance, with the service being provided in the language of 
their choice — the rest of the resources should be integrated into 
any event in a standardised manner.

Subtitling
Essential for people who are hearing-impaired but 
useful for everyone, particularly if the person does not 
speak the language fluently or if the speech is delivered 
in a large space. Jump to the tool:

T8 - Subtitling

Induction loop
This technical tool is essential for users of hearing aids 
or cochlear implants. Since deafness is an invisible 
disability, you’ll be helping many more people than you 
realise. Jump to the tool:

T9 - Induction Loop

Sign language interpreting 
A sign language interpreter is a professional who acts 
as a communication bridge between speakers of two 
different languages: sign language and oral language; 
and between two different communities: the deaf 
community and the hearing community. Jump to the 
tool: 

T8

T9

T10
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Audio description
The translation of visual images into words is an 
essential resource for people who are blind and those 
who cannot see the images clearly. Jump to the tool:

T11 - Audio description

Materials printed in alternative formats
Printed materials often have very small font that is 
difficult to read. A document printed with larger, clearer 
and well-contrasted font makes reading easier for 
everyone. Jump to the tool:

T11

T12 - Materials Printed in Alternative 
Formats

T12

4.5
Parallel activities

When organising an event, accessibility measures are often only 
considered for the main event.

But what about the complementary or parallel activities? What 
if these activities are related to the main event but organised by 
another entity?

The appropriate accessibility measures must also be in place for 
parallel events such as dinners, galas, receptions, visits, concerts, 
speeches and other activities.

Who benefits?

If you want to host an accessible event that everyone can enjoy, 
you’ll need to make sure that the accessibility chain is also fulfilled 
for parallel activities. Remember that if any link in the chain is 
broken, the experience cannot be considered complete.

43



When should measures be applied?

	O Venue: if the activities are held somewhere other than the 
main event site, you’ll have to check that this new venue 
meets the accessibility standards established by the 
organising body.

As for the main venue, it is recommended to visit 
the secondary venue beforehand to check the 
characteristics and degree of accessibility and to fill out 
the corresponding sections in the T4 - Venue Assessment 
Checklist.

	O Transport: if the secondary venue is located a certain 
distance from the main venue, you’ll need to revise 
accessible transportation options from both the main 
venue and the different accommodation locations. These 
are presented in T6 - Transport Requirements.

	O Catering: revise the provisions of T7 - Catering 
Requirements and make sure that the requirements are 
met.

	O Various events: when an event such as a dinner, a gala 
or a reception, etc., includes speeches, presentations, 
screenings, award presentations, etc., you’ll need to 
provide the necessary accessibility resources.

In section 4.4 Accessibility resources, you’ll find the 
measures that are required to guarantee the inclusion of all 
participants.

	O Recreational and sporting activities: when proposing 
recreational or sporting activities, focus on those that allow 
everyone to take part without any barriers to participation. 
You should also make the accessibility measures offered 
by the company you outsource to a key factor in your 
decision.
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5
Communicating and 
raising awareness

Many communication strategies follow these three basic steps:

1. Knowing

2. Doing

3. Raising awareness

Before communicating, you must be knowledgeable about the 
subject and have achieved something that warrants sharing.

You’ve already learned about accessibility (Knowing) and have 
incorporated its principles into the event’s organisation (Doing).
This chapter will now walk you through the third step, in which you 
let people know about these good practices (Raising awareness).
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5.1 
What should I communicate 
and how?

The best way to raise awareness about the accessibility of your 
event is via your website and social media pages.

Beyond what has already been said in sections 2.1 (Statement 
of Commitment) and 2.3 (Registration Form) on references to 
accessibility on your website, here are some other suggestions:

	O The section of your website describing the venue should 
include a sentence along the lines of “The conference 
venue is free of architectural barriers and has the following 
accessibility resources: Audio induction loop in meeting 
rooms, relaxation space, wheelchair loan service, ...”, etc.

	O The FAQ section should include a question on accessibility 
along the lines of “Is the conference venue accessible?”. 
The answer should indicate that it is a barrier-free venue 
that is well adapted to Persons with Reduced Mobility.

You could also include a more specific question about the 
sessions in the conference room along the lines of “Which 
accessibility resources are in place for the sessions?”. The answer 
should indicate that subtitling services, amplified sound devices, 
etc. will be in place. 

Remember that in the T4 - Venue Assessment Checklist, 
affirmative answers indicate good accessibility practices.

	O A photograph of the entrance to an auditorium with a sign 
indicating the existence of an Audio induction loop system 
(an ear with the letter ‘T’) will be well received on social 
media. This photo should be accompanied with a caption 
along the lines of “At [Conference name], we take care of 
our guests who are hearing-impaired”.

Everything that follows in Chapter 5 are guidelines and 
recommendations for better and more accessible communication 
which allows your message to reach as many people as possible.
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5.2 
Legibility guidelines

Legibility refers to the form and graphic design of your texts that 
make them easy and pleasant to read. You should consider the 
following aspects:

	O Contrast between the font and the background

	O Typography

	O Font size

	O Text alignment

	O Line spacing and kerning

These guidelines are applicable to all types of media and 
documents, whether digital or printed. If you incorporate them 
into your texts, you’ll make reading easier for everyone. This is 
particularly true for people who are visually-impaired or dyslexic.

Legibility is one of the two components of the “easy-to-read” 
principle, which takes into account the formal aspects of graphic 
design. The second component is readability, which refers to the 
linguistic aspects of content such as tone, syntax, terminology, 
sentence length, etc. Remember that a short, clear text reaches a 
wider audience more easily.

Jump to the tool:

T13 - Legibility GuidelinesT13

5.3
Website and social media 

When you seek to raise awareness of something, you need to 
consider the maximum number of people possible. Of course, this 
must include people with disabilities. Don’t fall into the trap of 
thinking that they’re not your target audience and that they won’t 
interact with your website or social media pages. Remember, there 
are many types of invisible disabilities. By taking this into account, 
you’ll be able to reach a wider audience.

Website

Holding a conference or event often requires the creation of a new 
website that has been specifically developed for the occasion. It is 
therefore a golden opportunity to make it as accessible and usable 
as possible from its conception. It is much easier to incorporate 
accessibility guidelines when building a new website than it is to 
remove digital barriers from an existing website.

What is an accessible website?

An accessible website has no barriers and can be navigated by 
users of all profiles, regardless of:

	O their capabilities

	O their device (computer, tablet, mobile phone, etc.)

	O their browser

	O their environment (noisy, low lighting, etc.)
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	O their way of interacting with the website (for example, not 
everyone can use a mouse or visual cursor). Some people 
browse exclusively using a keyboard, whereas others use 
a screen reader, etc.

Can accessibility and attractive design go 
hand in hand?

Of course they can! All that is needed is for the programming and 
design to incorporate the WCAG 2.2 guidelines for accessible 
content established by the WAI (Web Accessibility Initiative), a 
commission or working group within the W3C (World Wide Web 
Consortium) that oversees the accessibility of websites and digital 
environments.

Jump to the tool:

T14 - How to Make an Accessible Website

Advantages of an accessible website

	O Increased usability or ease of browsing: while a usable 
page is not always accessible, an accessible page will 
always be usable. This means that the browsing is easier 
and more comfortable for all users.

	O Improved search engine indexing and SEO positioning: 
measures such as textual alternatives and a good 
semantic structuring of the contents make it easier 
for search engines to retrieve information quickly and 
accurately.

	O Widened target audience: users can connect to 
accessible pages from any device. This considerably 
increases the number of potential users.

	O Brand image: corporate social responsibility is 
increasingly becoming an essential requirement.

	O Last but not least... compliance with the law: 
current regulations oblige institutions, public entities 
and companies that receive subsidies from public 
administrations to make their websites accessible.

T14
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Social media pages 

Communication via social media pages is increasingly important 
in the digital sector. The increased awareness of the importance 
of accessibility has led social media platforms to incorporate 
additional measures and mechanisms.

Check the accessibility section on the websites of social media 
platforms to learn about their measures and how they are applied.

Professional social media pages are usually managed by a person 
known as a Community Manager (CM). However, this role is often 
carried out directly by people who have not received professional 
training. In any case, there are general guidelines that apply to 
most published content, regardless of the social media platform.

Jump to the tool:

T15 - How to Publish Accessible Content on 
Social Media PlatformsT15



T17

5.4 
Documents

All event attendees must have access to the content, regardless 
of their personal, technological or environmental limitations. An 
accessible website that hosts non-accessible documents cannot 
be considered accessible. Digital barriers are difficult to detect 
because documents contain a hidden structure that lies beyond 
what we see on the screen.

In T16, you’ll find recommendations for creating accessible 
documents in Microsoft Word and PowerPoint. Following these 
guidelines, such as indicating the language of the text, will allow 
screen readers to assign the appropriate voice.

Once the base document has been generated, you need to make 
sure it remains accessible when you convert it to PDF. A PDF is a 
standard document that has its own tags and rules which must be 
applied and reviewed to ensure its accessibility.

Furthermore, search engines will better index and prioritise 
properly prepared documents over those that are not, which will 
improve the SEO positioning and reach of your documents.

Jump to the tool:

T16 - Accessible Document GuidelinesT16
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5.5
Terminology

Words matter. All terminology has certain connotations and 
is subject to debate. Just as society evolves, so does the use 
of words. The embrace of diversity and the adoption of social 
inclusion policies require the use of positive, respectful and non-
connotative terms.

Using appropriate language in the field of accessibility responds, 
among other things, to:

	O putting the person before the disability

	O avoiding euphemisms and paternalism

	O rejecting outdated, offensive or pejorative terms.

In 2006, the UN International Convention adopted the term 
‘Persons with disabilities’ to refer to individuals with functional 
diversity. This is the term that appears in current legal regulations.

In everyday speech, you may have doubts or make unintentional 
mistakes when referring to disabilities. No one wants to offend 
anyone and everyone wants to be respectful. The only thing 
getting in the way is a lack of knowledge.

Jump to the tool:

T17 - Table of appropriate terminology



5.6
Presentations

Presentations and working sessions are the crux of a conference. 
When the organisation’s scientific committee selects the topics 
and experts to form part of the programme, the focus is often 
placed exclusively on the content of the conferences and the 
profile of the speakers. While the ‘what’ and ‘who’ are obviously 
essential, ‘how’ it is communicated also matters a great deal.

If accessibility criteria are incorporated, communication between 
the speaker and their audience will be improved. These criteria 
cover the formal aspects that a speaker must take into account so 
that their message can reach everyone in as clear and fluent a way 
as possible. 

The recommendations are very simple and easy to implement. The 
access officer must send these recommendations to the speakers 
in advance and convince them of the added value they will bring 
to their presentations. 

If the speaker or lecturer has a disability, ask them what support(s) 
they need and help them where possible during the presentation.

Jump to the tool:

T18 - Recommendations for speakers on 
accessible presentations

T18

5.7
Support staff

Customer service is a basic pillar of communication. In the case 
of persons with disabilities, it is even more essential to treat them 
appropriately and respectfully.

Remember that attitudinal barriers are those that can generate 
the most frustration. They are also the most avoidable ones. Basic 
training can help prevent improper attitudes and behaviours.  
Without this training, you may accidentally say or do the wrong 
thing, despite having the best of intentions.

If you want your event to be enjoyable for everyone in attendance, 
you must have a knowledgeable organising committee and a well-
informed and trained customer care staff.

	O Informed: the staff must know what the accessibility 
resources are, what they’re for and how they are used. 

	O Trained: interacting with people with disabilities can create 
uncomfortable situations if you’re not used to doing so or 
aren’t aware of the guidelines for interacting with them.

 

Jump to the tool:

T19 - Recommendations for interacting with 
persons with disabilities

T19
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6
Evaluating for a 
better future 

61

Evaluating accessibility after the event is essential if you want to 
move forward and leave a legacy that allows for a better future.

This is the final task of the access officer. Their functions before, 
during and after the event have already been provided in the table 
in Chapter 2.2.

The accessibility activities must be evaluated both externally and 
internally.

1.	Externally: lget feedback from participants and speakers, 
especially from those who indicated any specific mobility, 
communication or dietary needs in the registration form.

To give participants the opportunity to both assess and 
express their views, we suggest asking them the following 
two questions:

- If you have used any accessibility services or resources, 
how do you rate them? (Excellent, Good, Fair or Poor)

- Do you have any comments or suggestions for 
improvement? (Open answer)

Below is an illustrative example in table format.



Please score the accessibility of the services from 
1 (poor) to 4 (excellent)

Score 1 2 3 4

Website usability

PRM accommodation

Adapted transport

Subtitling

Induction loop

SL interpreting

Audio description

Special dietary 
requirements

Attitude and treatment 
of the staff 

Do you have any comments or suggestions for improvement?

T20
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2.	 Internally: the organising committee must conduct a self-
evaluation. However, you should also take into account 
the views and opinions of the auxiliary staff who helped 
the attendees directly, either at the hospitality desk, in the 
cafeteria or during the bus transfers. Comments about their 
personal experience will be highly valuable.

On the other hand, remember that all subsequent actions 
must also adhere to the accessibility guidelines and 
recommendations. For example: sending the satisfaction 
survey, writing up the minutes of the sessions or uploading 
recordings from the conference to the website.

Finally, you must produce a short internal report that 
documents everything concerning the event’s accessibility. 
This last step is very important in leaving a legacy that will 
help to bring about improvements in the future.

Jump to the tool: 

T20 - Event Accessibility Report



7
Toolbox



T1
Accessibility Symbols

On this page you will find the most important and frequently used 
symbols concerning accessibility.

First, it is important that you recognise the four main symbols:

The wheelchair, which represents motor or 
physical accessibility, is used to identify
Persons with Reduced Mobility (PRMs).

The eye, representing visual accessibility.

The ear, representing auditory accessibility.

The two faces, representing intellectual or 
mental accessibility.

The International Symbol of Access (ISA) has traditionally been 
the wheelchair. However, this symbol only concerns mobility.  A 
new symbol of global accessibility which depicts a person within a 
circle is being increasingly implemented. 

The two most commonly used versions are:

The new symbol proposed by the UN, 
inspired by the “Vitruvian Man”, which 
encompasses all accessibility needs.

A stylisation of the above, which is 
primarily used for accessibility in digital 
environments.
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There are also icons for different accessibility resources.



A letter ‘A’ with a ‘+’ sign, for the use of large print 
format and optical aids.

6 dots, for the braille reading and writing system.

A hand, for tactile elements and everything that can be 
touched.

A screen with subtitles, for subtitling.

The letters ‘AD’ with sound waves, for audio description.

A dog in a harness for service dogs, not just guide dogs 
for the blind.

An ear with sound waves, for personal sound 
amplification.

An ear with the letter ‘T’, for induction loop.

The letters ‘SL’ within a hand, for sign language.

Of all these symbols, only two are universally recognised: the ISA 
(wheelchair) and that proposed by the UN (“Vitruvian Man”). 

Some symbols that are not universally recognised but are still 
widely used include: the one of the ear, the one of the ear with 
the letter ‘T’, the six dots for braille, the ‘AD’ for audio description 
and the stylised “Vitruvian Man”. As for the rest, several graphic 
versions exist that have not been universally adopted. For 
example, visual accessibility is sometimes represented by the 
figure of a blind man with a cane instead of a simple eye. Sign 
language is also occasionally represented by a symbol depicting 
two hands.

If you implement any of the aforementioned accessibility 
measures, you should raise awareness of them by using the 
corresponding symbols.

Where can I use these symbols?
	O The symbol of the letter ‘A’ with the ‘plus’ sign can be used in 

the conference programme if it uses enlarged letters.

	O The stylised “Vitruvian Man” symbol can be used on the 
event’s website if it meets accessibility requirements.

	O The symbol of the dog in the harness can be used at the 
hospitality desk, accompanied by the sentence “Service  dogs 
are welcome here”.

	O The symbol of the ear with the letter ‘T’ can be used at the 
entrance to the rooms if they have an induction loop system  
in place.
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T2 
Registration Form Model

The registration form is a good place to set out the accessibility 
measures that you will implement during the event, if you already 
know what these will be. It also represents a direct point of 
contact with potential participants (both speakers and delegates) 
where you can inquire about their specific needs.

An opening paragraph can be effective. For example:

“We want this event to be as inclusive and accessible as 
possible for everyone in attendance. To ensure that we can 
meet your specific needs, you are kindly asked to fill out 
this registration form. Your answers will help us make the 
appropriate adjustments so that you can enjoy the event”.

lWhen asking questions in the registration form, you’ll need to find 
the right formula to identify the person’s needs so that you can try 
and address them. It is therefore useful to ask the attendees which 
events or activities they are planning on attending so that you can 
factor in any adjustments.

When asking if the attendee has any additional requirements, you 
will need to refer to three main areas: mobility, communication and 
diet.

These questions may be:
 

	O  A general and open question which leaves space for the 
attendee to answer. For example:

“If you have any specific mobility, communication or 
dietary requirements, please let us know in the box  
below.”

	O More direct and specific questions tailored to each 
section, informing the attendee of what you can offer them 
and leaving room for comments. For example:

1- Do you have any specific mobility requirements?
Tick the ones that apply:

•	 Accessible parking space reservation

•	 Accessible hotel room

•	 Wheelchair loan

•	 Travel assistance

•	 Adapted transport

•	 Other mobility-related needs (please specify).
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2- Do you have any specific communication requirements 
during the conference?
Tick the ones that apply:

•	 Subtitling

•	 Induction loop

•	 Sign language interpreting

•	 Audio description

•	 Large print format

•	 Braille printing

•	 Others (please specify)

3- Do you have any specific dietary requirements?
Tick the ones that apply and provide details in the space 
provided:

•	 Allergy to...

•	 Intolerance to…

•	 Vegan diet

•	 Vegetarian diet

•	 Kosher cuisine

•	 Halal cuisine

•	 Others (please specify)

4- Do you have any other accessibility requirements that 
are not mentioned in the form? For example, do you rely 
on an access dog or need to travel with your personal 
assistant? If yes, please specify.

You must also set a deadline for requests for adaptations. For 
example:

“To allow us to properly attend to your needs, please return 
the completed form to us by [state date 2 weeks prior to the 
event’s start date]”.

Finally, you will need to provide the contact details of the access 
officer. Provide an email address (which can be a generic “info@” 
or “accessibility@” address), a telephone number and, if possible, 
the name of the accessibility officer. For example:

“If you have any additional comments or questions, please 
contact [access officer’s name] by sending an email to [email 
address] or calling them at [telephone number].”

You can also include a closing sentence which lets them know 
that you’ll be in touch. For example:

“We’ll contact you to confirm the definitive arrangements.”

“Our access officer will get in touch with you to confirm 
arrangements.”
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Requirements of speakers

Speakers may also have specific requirements. Besides asking 
about their technical requirements insofar as projection, sound, 
internet access, etc. are concerned, you should also ask them if 
they have any accessibility requirements for the presentation as 
well as any dietary or mobility requirements. For example:

“Do you require any specific accessibility adaptations for your 
presentation?

Tick the ones that apply:

•	 Wheelchair-accessible stage

•	 Furniture requirements (table, seat, lectern, etc.)

•	 Subtitling

•	 Induction loop

•	 Sign language interpreting

•	 Audio description

•	 Others (please specify)

If you have any additional comments or questions, please 
contact [access officer’s name] by sending an email to [email 
address] or calling them at [telephone number].”

T3 
How to Make a Virtual Event 
Accessible

In order to make your events more inclusive, you need to make 
sure that virtual meetings are also accessible to everyone.

Accessibility must not, therefore, be an afterthought. Rather, it 
should be a fundamental part of the planning process from the 
very beginning.

Previous steps
	O Choose an accessible platform (e.g. Zoom or Microsoft 

Teams) that supports persons with disabilities:

•	 It must be compatible with assistive devices such as 
screen readers.

•	 It must be navigable with just the keyboard, without 
the use of a mouse.

•	 It must allow screen scaling.

•	 It must allow the use of subtitling. The host or 
administrator must activate the subtitling feature at 
the beginning of the session. The user can then decide 
whether or not they want to use it.

•	 Remember that auto-generated subtitles are of a lower 
quality than those produced by a professional linguist. 
A considerable progress has been made with English 
and Spanish auto-generated subtitles.
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•	 This system allows you to record the subtitles 
generated during the call and review them afterwards, 
giving you a final video that is accessible enough to 
upload to your website or social media pages.

	O When you announce the event, you must communicate the 
chosen platform and highlight its accessibility features.

	O The registration form is a good place to ask if the attendee 
has any other requirements. Here, you can also add the 
contact details of the access officer. You must also set a 
deadline for these requests.

	O You should plan who will monitor and track accessibility 
during the meeting. This will often be the host or the 
moderator.

	O Some people require access to the materials in advance 
so that they can adapt to them as necessary. In this case, 
you should share all the material before the meeting (PDFs, 
PowerPoint presentations, Excel spreadsheets, graphs, 
videos, etc.).

	O You should provide a short list of good practices for 
moderators, hosts and speakers:

•	 Speak through a headset mic, not an open mic. This 
will make it easier for everyone to hear you. This is 
particularly relevant for people with hearing loss or 
with little knowledge of the language, for professionals 
such as interpreters and for the speakers themselves 
when taking questions from the audience.

•	 It is advisable to choose environments and 
backgrounds that are as neutral as possible. It is 
considered helpful to use a blurred background. 
This will help to capture the attendees’ attention and 
prevent distractions. It will also make it easier to read 
the subtitles.

•	 When a person speaks, their camera must always 
be on and their face must be well lit. This will help to 
improve communication and let the audience know 
who is speaking. For attendees who are hard of 
hearing or not fluent in the language, this is particularly 
helpful for lip reading.

•	 Regulate the volume and speed of oral expression. 
This will make it more accessible for the general 
public, particularly those who are hard of hearing or 
not fluent in the language. It will also give interpreters 
more time to do their job.
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•	 Speakers are encouraged to follow the “6 second rule”, 
which states that 6-second pauses are a good way 
to give the audience time to process the information. 
This approach makes the session easier to digest. 
It is particularly recommended when opening a new 
document on the screen and when listening to or 
answering questions.

•	 Describe the images contained in the presentations 
(PDFs, PowerPoint presentations, Excel spreadsheets, 
graphs, videos, etc.). This will ensure that they are 
understood by people who are blind or visually-
impaired, as well as those who have poor signal on 
their device or a screen that is too small to display 
images in high quality.

•	 Include audio descriptions for videos. Videos 
containing nothing but images and background 
music are frustrating for blind people as they cannot 
understand them.

•	 Include subtitles for videos. Besides subtitling the 
session itself, you must also include subtitles for 
audiovisual materials for people who are hard of 
hearing or not fluent in the language.

When you are online
	O Introduce the meeting by explaining the agenda and 

expected duration of the meeting, describing the available 
accessibility features and explaining how to activate them 
(for example, “turn on subtitling”).

	O Establish rules that improve accessibility for all 
participants, such as:

•	 Muting their microphone when they’re not talking.

•	 Having their camera turned on (if they’re comfortable 
with it).

•	 Regulating the volume and speed of their interventions.

•	 Explain that everyone should feel free to apply the 
“6-second rule” to encourage reflection, and that they 
shouldn’t feel pressure by the periods of silence.

	O To facilitate access to the documents that are shared on 
the screen, you could also share them in the chat space.

	O If the chat space is used in debates or discussions, you 
should read the comments out loud so that everyone can 
hear them.

	O Make sure that people asking questions verbally use a 
microphone so that everyone can hear them.
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Recommendations for the future

	O Assess the event along with the organisers and review the 
comments submitted by participants.

	O Identify what worked well and what didn’t.

	O Incorporate the comments when planning the next virtual 
event.

By prioritising accessibility and actively involving members 
with disabilities, you can create virtual events that are inclusive, 
welcoming and which allow all attendees to fully participate.

Relevant links:

	O Selecting an accessible remote platform

	O Accessibility on the Zoom platform

	O Accessibility on the Microsoft Teams platform

https://www.w3.org/TR/remote-meetings/#selection
https://www.zoom.com/en/accessibility/
https://support.microsoft.com/en-us/office/accessibility-tools-for-microsoft-teams-2d4009e7-1300-4766-87e8-7a217496c3d5


T4
Venue Assessment Checklist

This tool, just like T5, is an Excel spreadsheet with an external link. 
This means that it can be filled out without the need to submit a 
hard copy.

It is a questionnaire consisting of 87 clear and direct questions 
that are categorised based on whether they concern spaces 
(outdoor environment, hall, toilets, meeting room, etc.) or topics 
(website, staff).

It is a simple, jargon-free didactic tool consisting of easy-to-
answer “yes” or “no” questions. The more “yes” answers, the 
more accessible the venue is.

Important: The “Meeting rooms” section must be filled out 
separately for each meeting room.

Open the T4 - Venue Assessment Checklist spreadsheet.

T5
Accessible Accommodation 
Assessment Checklist

This tool, just like T4, is an Excel spreadsheet with an external link. 
This means that it can be filled out without the need to submit a 
hard copy.

It is a questionnaire consisting of 82 clear and direct questions 
that are categorised based on whether they concern hotels 
(reception area, rooms, adapted room bathrooms, restaurant, 
cafeteria, etc.) or topics (website, staff).

It is a simple, jargon-free didactic tool consisting of easy-to-
answer “yes” or “no” questions. The more “yes” answers, the 
more accessible the accommodation is.

Open the 
T5 - Accessible Accommodation Assessment Checklist 
spreadsheet.
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T6 
Transport Requirements

This section will explain what information you need to obtain 
about each of the commonly-used means of transport.

Public transport

The most common means of public transport are metro, bus and 
tram. These are required by law to be accessible for persons 
of reduced mobility (PRMs). You will need to evaluate the most 
frequent routes, such as from the airport or hotel to the event 
venue.

What should I focus on?
•	 Short walking distances between all points.

•	 Safe and accessible crossing points (e.g. those with 
acoustic traffic lights).

•	 Lighting, non-slip flooring and routes.

•	 Wide pavements along the route.

•	 Lifts and/or ramps with handrails as an alternative to stairs 
and steps.

•	 Well-contrasted signage with large, clear lettering.

•	 Ticket vending machines that are accessible for people 
with sensory disabilities or in wheelchairs.

•	 Ticket validating machines that are accessible for people 
in wheelchairs.

•	 Same-level ramp or lift access to the train, bus or tram.

•	 Sufficient space for wheelchairs to be anchored and 
secured inside the vehicle.

•	 Marked priority seating for people with disabilities.

•	 Visual and acoustic announcements of stops.

•	 Schedules and frequencies.

Who benefits?
The information collected shall be useful for all participants. You 
will have to specify this information in the communication on 
“How to get there”, including the links to the websites and apps of 
transport service providers.

Accessible parking spaces

You should stress that accessible parking spaces are reserved 
exclusively for holders of the official Parking Card for people with 
disabilities, which is for individual use only.

What does the card allow?
The card is designed to facilitate travel, personal autonomy and 
the integration of Persons with Reduced Mobility. When the 
original card is displayed in a visible place, it gives the holder the 
right to:

•	 Travel in any vehicle.
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•	 Stop the vehicle momentarily at any point on public roads, 
as long as doing so does not impede the movement of 
other vehicles or pedestrians.

•	 Park for as long as needed in parking spaces with 
restricted hours and loading and unloading areas.

•	 Use the card in all municipalities in Catalonia, the rest of 
Spain and the member states of the European Union.

What should I do?
Make sure that the venue, hotel, restaurant, recreational space, 
etc. has reserved parking places and ensure that they are well 
signposted and appropriate. You must inform the establishment 
about the number of reservations and the name of the card 
holders.

Applicants must be informed of:

•	 The address of the entrance to the car park.

•	 The procedure (if there is one).

•	 The location and number of the reserved place.

•	 The cost (if there is one). To avoid any discrimination, you 
must offer the same conditions that you offer to the rest of 
the attendees.

•	 Telephone number and email address of the contact 
person.

Adapted taxi or vehicle

While some people will want to blend in with the group, others will 
prefer to travel separately so as not to attract attention or be an 
inconvenience to others.

In the second case, you will need to procure an adapted taxi or 
vehicle for the journeys or activities. Either way, you will need to 
ask the person directly about their preferences, and be careful 
not to discriminate or offend them when discussing the transport 
issue.

What should I focus on?
•	 Different taxi or accessible vehicle options, with complete 

details and links to the company’s website or app.

•	 Information on service availability (e.g. 24-hour service).

•	 Information on advanced booking requirements (e.g. 48 
hours in advance) and any service limitations.

Remember that not all wheelchair users can transfer from the 
wheelchair to the vehicle. Their ability to do so will determine the 
type of adapted vehicle required.

For participants who wish to use this service on their own accord, 
inform them accordingly as you would for any other means of 
transport.

87



Adapted buses and minibuses

The company must guarantee that its buses and minibuses meet 
the needs of your users.

Very importantly, it must also guarantee that its drivers have 
received training on how to deal with people with disabilities 
and that they are familiar with the vehicle’s specific adaptation 
mechanism.

What should I focus on?

•	 That the lifting platform, the entrance and the space inside 
the bus are big enough.

•	 That the total weight of passenger + wheelchair does not 
exceed the platform’s maximum weight capacity.

•	 If you use adapted buses or minibuses, you must ensure 
that the transfer areas are large enough for wheelchair 
users. Lastly, when planning the times, remember that 
each stop takes time and will extend the duration of the 
journey.

Wheelchair and mobility scooter rental

There may be times at which organisers need to rent a wheelchair 
or a mobility scooter.

Who benefits?

•	 PRMs who don’t use a wheelchair in their day-to-day life, 
but who require one for longer distances when they travel.

•	 PRMs whose wheelchair or mobility scooter has been 
damaged or lost by the transportation company.

•	 People who have acquired short-term injuries but want to 
participate in the scheduled activities.

•	 Participants in activities that take place over long 
distances they cannot cover on foot.

What should I focus on?

•	 Different rental options with full details and links to the 
company’s website or app.

•	 Material type, availability and booking requirements.

•	 Rates and timetables (collection and return).

In any case, you will have to contact the individual and make the 
necessary adjustments to the transport logistics.
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T7 
Catering Requirements

When a place is accessible, all of its spaces are comfortable 
and welcoming for everyone. Removing barriers and anticipating 
people’s needs are key to making sure that everyone feels 
welcome in the dining and interaction spaces. Here are some 
essential guidelines for achieving this:

Circulation space

Make sure that the spaces between tables, buffets carts, bars and 
seating areas are wide enough for users of wheelchairs, mobility 
scooters, crutches or service dogs to pass through. Remember 
that chairs tend to stick out more when they are occupied.

When a wheelchair user has to sit at a table in a restaurant 
or dining hall, make sure that the route from the entrance is 
completely accessible and unobstructed.

Seats

Dining areas should have seats for users of wheelchairs and 
mobility scooters evenly distributed throughout the room. 
Whenever possible, try not to relegate PRMs to a single area. 
Instead, try and include them with the rest of the group.

For special moments such as coffee breaks, cocktail receptions 
and standing meals in which food is served on high tables, 
you must provide lower tables and seats for those who require 

them. For those who prefer to remain in their wheelchair or 
mobility scooter to eat, you can easily remove a seat to naturally 
accommodate them at a table.

If the person decides to transfer to a seat, you will need to provide 
a storage location for their mobility vehicle. It is very important to 
ask permission from the person before moving their wheelchair, 
mobility scooter, crutches, etc. out of the way of other users and 
waiters. You must tell them exactly where you will leave it.

Tables

There must be under-table clearance measuring 70 cm high by 
60 cm deep, as this will allow the wheelchair user to get close 
enough to the table. The table must be no higher than 85 cm off 
the ground so as to ensure a good view from the wheelchair.

Wheelchair users are not able to reach anything that is more than 
70 cm from the perimeter of a table. Particular attention should be 
given to this when presenting the food in buffet settings.
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Menu

When it comes to serving meals, it is advisable to have a written 
menu both at the table and at the beginning of the buffet line. This 
will help people with dietary restrictions and/or preferences make 
decisions.

You will need to add indications for the dishes, detailing what they 
contain in terms of ingredients and possible allergens.
The food menu must be printed on non-glossy paper in large, well-
contrasted font and, if necessary, include braille.

Assistance

Some people with disabilities may need assistance, especially 
in buffets. You should ask the person if they need assistance 
beforehand and wait for them to tell you what they need.

Make sure that the waiting staff are duly trained on how to interact 
with people with disabilities, and ensure they are well equipped 
to answer detailed questions about the food and its preparation 
process.

	O People who are blind

People who are blind or visually-impaired may need 
waiters to read them the menu and serve them food at the 
buffet. They may also need directions on where to sit or to 
be escorted to the toilet door.

	O People who are deaf

People who are deaf or hard of hearing may need written 
notes or other methods to communicate and obtain 
information about items on the menu.

	O PRMs

People with disabilities affecting their strength, dexterity or 
mobility, or those who rely on service dogs, may need help 
carrying trays, food or drinks from the buffet to their table.

	O service dogs

Remember that some people with disabilities may be 
accompanied by an service dog that, when duly accredited, 
has the right to enter all public spaces. Make sure that 
all event and facility staff are aware that service dogs 
are allowed in public spaces, hotels, convention centres, 
restaurants and other places where food is served.
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Allergies, intolerances and diets

The number and variety of special dietary requests has grown 
significantly in recent years. These may be issued by attendees 
with food allergies and intolerances, as well as those who need to 
follow special diets for medical, health, religious or other reasons.

Dietary needs may include avoiding common allergens (milk, soy, 
egg, wheat, peanuts, nuts, fish and shellfish), as well as adhering 
to vegan, vegetarian, kosher or gluten-free, sugar-free or fat-free 
diets.

It is the responsibility of the participant to notify you in advance, 
through the registration form or the access officer, of their dietary 
needs. This will allow you to make the appropriate arrangements. 
If you cannot meet their request, you must let them know at the 
earliest possible opportunity.

Participants can be issued with some sort of identifying element 
that indicates their dietary requirements, allowing the waiting and 
room staff to identify and serve them accordingly.

Buffets

The buffet format can be a good option for all audiences, as 
long as there are enough staff to meet the needs of all diners in 
attendance. You must also take the following recommendations 
into account:

•	 Buffet tables must be no more than 85 cm high and 70 
cm deep. This will allow wheelchair users to view, select, 
reach and serve themselves the food.

•	 You must ensure that plates, cups and other tableware, as 
well as food and drinks, are placed within reach of people 
of short stature or who use mobility devices.

•	 Avoid multi-level food presentations.

•	 Keep food warmers as low as possible.

•	 Avoid the use of chafing fuel, as this can cause reactions 
in people with chemical sensitivities.

•	 Group foods by type, such as starters and salads, main 
courses, desserts, etc. Avoid placing foods for those 
with special dietary needs, such as gluten-free, in their 
own specific sections. Many dishes will be suitable for 
everyone.
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T8 
Subtitling

What is it?

Subtitling is an alternative and complementary system to oral 
communication. Subtitles are the transcription of the audio 
content of a video which consists of text, sound and image, shown 
at the bottom of the screen.

Who benefits?

Subtitles are a must for people who are hearing-impaired who 
cannot hear spoken communication. Subtitling is very useful for 
everyone, as the written support reinforces and facilitates the 
understanding of the oral speech.

Subtitles are also useful for:

	O Those who don’t understand the language fluently.

	O Instances when the sound is not clear enough.

	O Those in very noisy or very quiet environments.

	O Those who do not have good signal.

What types of subtitles are there?

In terms of language, there are two main types of subtitles:

	O Intralinguistic subtitles, which are in the same language 
as the original.

	O Interlinguistic subtitles, which are translated from another 
language.

Subtitling for the Deaf and Hard of Hearing (SDH) is generally 
intralingual, and also includes indications of context-relevant 
sound information such as noises, music, etc.

In terms of context, there are two types of subtitling:

•	 Live subtitling (or simultaneous subtitling), which is used at 
events, conferences, etc.

The professional subtitler transcribes the words of the 
speaker or lecturer in real time. This can be done both on-
site and online.

It is similar to a simultaneous translation on a technical 
level, meaning you need to provide a space and a good 
audio equipment for the professional subtitlers. You 
will also need the appropriate equipment to broadcast 
the subtitles. These will appear at the bottom of the 
screen that the speaker’s face is shown on while they are 
speaking. This allows their lips to be read in real time, 
which is especially useful for oral deaf people who read 
lips and facial expressions to better understand what is 
being said.

•	 Deferred subtitling, for audiovisual materials.

In this case, the subtitles are added afterwards. As an 
alternative to subtitling professionals (who are always 
a guarantee of quality), AI applications and audiovisual 
content platforms such as YouTube and Vimeo allow you 
to add subtitles automatically.
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AI-generated subtitles in Spanish and English have an 
acceptable quality.

In any case, it will always be necessary to review and edit 
subtitles to resolve possible errors, which are often caused 
by poor sound quality.

When adding subtitles to the video, you’ll have the option to add:

•	 Closed captions: The user can turn them on or off 
depending on their needs.

•	 Open captions: These are embedded in the video and 
cannot be turned on or off by the user.

How are they used?

The general guidelines to take into account are:

•	 Subtitles should be centred at the bottom of the screen, in 
a static position.

•	 Sound effects must be displayed in the top-right of the 
screen.

•	 They must span no more than two lines of text, with a limit 
of 37 characters per line.

•	 The font should be as readable as possible.

•	 Size-32 Arial, Verdana or Helvetica sans-serif fonts, using 
both upper and lower cases, are recommended.

•	 For good contrast, it is recommended to use light colours 
on dark backgrounds.

•	 The maximum number of characters per second (cps) is 
15.

•	 To be readable, a subtitle must be on the screen for at 
least 1 second and at most 6 seconds.

•	 Ensure as much synchronisation as possible between 
subtitles, images and sound.

The UNE 153010 standard for subtitling for the deaf and hard of 
hearing, of May 2012, regulates the quality and homogeneity of 
subtitles.

Relevant links
	O How to add subtitles on Vimeo

	O How to add subtitles on YouTube
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What is it?

The induction loop is a sound amplification system that connects 
to an audio output, transforms the signal into a magnetic field and 
sends it directly to cochlear implants or hearing aids set in the ‘T’ 
(standing for “Telecoil”) position.

Not only is the sound amplified, but it is also clear, isolated from 
ambient noise and free of echoes or reverberations.

Who benefits?

This system is essential for hearing aid users. It works sending the 
amplified and isolated sound straight from the microphone to the 
attendee’s hearing aid or cochlear implant.

The symbol that indicates the existence of an induction loop is the 
ear with the letter ‘T’.

T9 
Induction Loop

What types are there and where are they used?

Perimeter or fixed installation
This is a fixed device connected to one or several microphones 
which is/are connected to an induction cable that runs through 
along part or all of the room’s perimeter. This system is ideal for 
conference rooms and auditoriums.

For this type of installation, you’ll have to:

•	 Check that it works correctly with the sound and room 
technicians.

•	 Inform speakers and participants of its existence.

•	 Place a sign at the entrance to the room with the 
corresponding symbol.

•	 Activate the system for all sessions in which microphones 
are used.

When the room does not have a fixed system, you can also 
arrange for sound and audio technicians to install a temporary 
induction loop in a specific part of the room.
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Portable or desktop loop
This system requires no installation. It consists of a visible 
amplifier placed on the table and a microphone for the speaker to 
speak into. This conveniently marked system is activated at the 
user’s request and improves communication within a one-metre 
radius.

This device is ideal for one-to-one interactions e.g. at reception, 
the information point or the hospitality desk. It can even be used 
for meetings at a table involving two or three participants.

Individual or necklace loop
This necklace-shaped device is designed for individual use and 
replaces headphones. It facilitates accessibility to multimedia 
devices such as FM receivers, simultaneous translation receivers, 
audio guides, sound players, mobile phones, etc.

It connects directly to the device’s headphone outlet via a 
standard 3.5 mm minijack.



	O

T10 
Sign language 
interpreting

Sign language is the language of the community of deafand 
deafblind signers. It is based on visual and gestural 
communication.
It is a language with its own grammar and alphabet. In the case of 
Catalonia, the LSC or Catalan Sign Language is used. This official 
language was approved by the autonomous region’s parliament in 
2010.

The other official language used in the rest of Spain is the LSE or 
Spanish Sign Language.

Many countries or territories have their own sign languages. For 
example:

BSL - British Sign Language

	O ASL - American Sign Language

	O LSF - Langue des signes française

	O DGS - Deutsche Gebärdensprache

There is also International Sign (IS), which is a kind of auxiliary 
lingua franca which shares a base with other languages.

Which professionals are involved?

Sign language interpreters are skilled professionals in sign and 
oral language who are capable of transmitting a message from one 
language to the other and vice-versa. Signing deaf people rely on 

their skills in order to communicate.

How is it implemented?

In order to optimise understanding, you must adopt the following 
measures:

•	 Place the interpreter in a visible and well-lit location.

•	 Place the interpreter to the left or right of the speaker, 
ensuring that they can be seen at all times.

•	 Reserve seats right in front of the interpreter for those who 
rely on sign language interpretation.

•	 If there are screens broadcasting what takes place on 
stage, the face of the person speaking must be displayed 
at all times in order to facilitate understanding.

For more information:
Law 17/2010 on Catalan Sign Language (CA)
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T11 
Audio description

What is it?

Audio description is a communication support service that 
consists of translating visual images into verbal language. This 
service allows everyone in attendance to understand the content 
that is being projected onto a screen, for example.

Presentations tend to lean heavily on visual content. You must 
therefore identify the relevant visual elements and work out how to 
explain them in words.

Who benefits?

These verbal descriptions are essential for people who are blind, 
and useful for people who are visually-impaired or who are located 
too far from the screen to make out all the details.

Audio descriptions are regulated by the UNE 153020 
standard established in 2005, which sets forth a code of 
good practices and the basic requirements for creating 
Audio descriptions in all areas.

When should they be used?

At any time, especially once you know that there are people 
who are blind or visually-impaired in the audience or when the 
audience is very large. Some other recommendations include:

	O Briefly describe yourself when introducing yourself to the 
audience.

	O When projecting slides with text, read the text aloud and 
include any relevant information about the visual content 
of the slide.

	O You will also need to describe tables, infographics, 
charts, graphs, diagrams, sketches, etc. It’s generally 
recommended to describe the slide’s content in order, from 
left-to-right and top-to-bottom.

	O When projecting slides with images, you should only 
provide a simple explanation of what is shown on the 
screen.

	O In the case of video screening, important visual 
information must be included in the video’s audio. If it 
is not included in the audio, you will need to describe it 
during the screening or consider not screening it at all.
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T12 
Materials printed in 
alternative formats 

In the digital age, one would think that all documents are 
accessible. However, this couldn’t be further from the truth. You 
can find out why that is the case in Chapter 5, which focuses on 
communication.

At events, lots of printed materials cannot be accessed by all 
attendees.

You must provide alternative formats for people with strained 
eyesight, those who are blind or visually-impaired or when the 
event is held in a low-light environment. These alternative formats 
include documents and elements in large print, raised images and 
braille.

What are they for?

In the case of events, these are printed materials that facilitate 
communication, such as:

	O Identification cards

	O Invitations, tickets, programmes and dossiers

	O Plans and temporary signage

	O Accessibility information

	O Food and menu information

All of these elements are important in ensuring the autonomy of 
the attendees at a conference or related activity.

What formats are there?

Most materials are printed in a small font which a large part of 
the public find difficult or impossible to read. In order to make 
materials more accessible for everyone, you should consider:

	O Large print: write in size-18-or-larger font and follow 
legibility recommendations on contrast, colours, paper 
type, etc., as described in T13 - Legibility Guidelines.

You should apply these recommendations to all 
communication materials. Generally, you will need to trim 
texts down so that they only contain essential information, 
as this will make reading faster and easier for everyone.

	O Raised images: in unfamiliar locations, all attendees will 
appreciate being given a map of the facilities, rooms, 
services, etc. A raised map in contrasting colours, large 
print braille and a clear legend, improves everyone’s 
understanding of the different areas. These features will 
make it easier for attendees to read the information quickly 
and find their bearings, and will be particularly helpful for 
people who are blind or visually-impaired.
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	O Braille: while people who are not visually-impaired read 
everything that they see, those who are blind rely on braille 
for personal and autonomous reading.

Ensuring that people who are blind can access content in 
their preferred format must be an absolute priority.

Where should they be used?

These formats must be considered as early as the registration 
form. This will give you time to produce the materials in the 
required formats and hand them out to attendees upon their 
arrival.

Having accessible materials at the hospitality desk is also 
recommended. These documents are a useful way of presenting 
information to attendees when standing up or in low-light 
conditions. They are therefore practical for all members of staff, 
particularly those who face the public.

You should use these materials to describe the food and drink 
served at the catering facilities, ranging from the coffee area to 
the canteen. This will be particularly useful at the buffet carts.



In graphic design, ‘legibility’ refers to the formal characteristics 
that make a text easy and pleasant to read.
These guidelines or recommendations apply generally to both 
printed documents and signage as well as digital texts (websites, 
PDFs, etc.).

	O Colour contrast

Reading is easier when there is a good colour contrast. 
Black font on a white background, or dark colours over a 
light background, are considered good combinations.

Some examples of well-contrasted colour combinations 
include white and dark blue; black and yellow; green and 
white; and red and white.

  

T13
Legibility Guidelines

Texts with a negative contrast (white text on a black 
or dark background) mustn’t be very long. These 
combinations are only recommended for titles, quotations 
or sentences. For better clarity, leave a little more space 
from letter-to-letter and line-to-line than in texts presented 
with a positive contrast. This is because the light letters 
in the negative contrast have to “compete” more with the 
darker background colours.

	O Font type and size

•	 Sans-serif fonts are more recommended than serif (or 
Roman) fonts. Some of the most recommended sans-serif 
fonts include Arial, Verdana and Helvetica.

•	 Italics is useful for emphasising single words, but is not 
recommended for continuous reading because the slant 
hinders legibility.

•	 Underlining strings of words in the middle of a sentence is 
not recommended either, as readers might confuse this for 
a hyperlink.

•	 Avoid writing long sentences entirely in capital letters, as 
this would remove some helpful reading queues such as 
differences in letter height.
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•	 The font should be size 12 or above, although this may 
vary depending on the font chosen. Larger fonts may be 
used depending on the case. For example, size-16 or 18 
fonts with a minimum inter-line spacing of 1.5 are suitable 
for dossiers.

•	 Reading distances must be taken into account when 
designing signage.

Sign font height according to 
reading distance

Distance Minimum Recommended 
height height

>5.00 m 7.00 cm 14.00 cm

4.00 m 5.60 cm 11.00 cm

3.00 m 4.20 cm 8.40 cm

2.00 m 2.80 cm 5.60 cm

1.00 m 1.40 cm 2.80 cm

0.50 m 0.70 cm 1.40 cm

	O Alignment

Contrary to how text is often formatted, it should be 
aligned to the left and not right-justified. A text is more 
legible when it does not occupy a perfectly square or 
rectangular block. Rather, the right-side of the text should 
zigzag according to the length of the last word in each line. 
This helps the reader to jump more easily from one line to 
the next and avoid getting lost in the text.

	O Line spacing and kerning

In order to be more legible, texts need room to breathe. 
According to the digital accessibility guidelines, there must 
be an inter-line spacing of 1.5 points within a paragraph, 
and an inter-paragraph spacing of at least 6 points.

You will also need to regulate the kerning to make sure that 
the text is not too visually dense. When there is not enough 
space between the letters, it can be harder to read the 
text.

All of these measures help to make reading easier for 
everyone, especially people who are visually-impaired or 
dyslexic.
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T14 
How to Make an Accessible 
Website

Digital accessibility is regulated by law. It requires compliance with 
a number of technical principles when designing, maintaining and 
updating a website.

Whose responsibility is it?

In principle, three main figures are involved in the construction of a 
website:

	O The content creator: responsible for collecting or creating 
texts, images, videos and audios and presenting them on 
the page, usually through a content manager.

	O The designer: responsible for the digital appearance and 
organisation of the elements.

	O The developer and/or programmer.

You must make sure that each figure is aware of the accessibility 
requirements and principles and ensure that they apply them from 
the start.

WAI guidelines

In the area of programming and digital design, the Web 
Content Accessibility Guidelines (WCAG) produced by the Web 
Accessibility Initiative (WAI) must be applied. These guidelines are 
updated on a periodic basis. 

In Spain, the standard that incorporates and applies these 
guidelines is UNE-EN 301549. This standard is based on the 
European regulations on functional accessibility requirements for 
ICT products and services.

These guidelines apply to desktop and laptop computers, tablets 
and mobile devices. By complying with these guidelines, your 
online content will be more accessible for all audiences.

There are 3 levels of compliance with online accessibility:

	O Level A: Priority 1 or basic compliance.

	O Level AA: Priority 2 or optimal compliance.

	O Level AAA: Priority 3 or excellent compliance.

The recommended compliance level is AA (double A).

The use of the AA logo indicates that all Priority 1 and 2 
checkpoints established by the WAI have been met.

The WCAG Guidelines are based on 4 principles: perceivable, 
operable, understandable and robust. These are found across the 
13 guidelines and 78 compliance criteria.
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What is the purpose of the 4 principles?

1.	 Perceivable: ensuring that information is easily perceived 
by sight, hearing (with a screen reader) or touch (braille).

2.	 Operable: ensuring that the website can be navigated, that 
data can be entered and that the content can be interacted 
with in different ways (keyboard instead of mouse).

3.	 Understandable: ensuring that content with good 
structure, layout and wording can be processed and 
understood.

4.	 Robust: ensuring that the content can be reliably 
interpreted by a wide range of technologies, such as 
browsers (very important for improving SEO), devices 
(PC, tablet, smartphone, etc.) and assistive technologies 
(screen reader, braille line, etc.).
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1. How can I make it more Perceivable?

First principle: ensuring that the information is easily perceived.

Images
	O Alt text: All images that form part of the content of a page 

must have an alternative text, or “Alt text”.

•	 When an image is decorative, the Alt text field can be left 
empty. However, it still needs to be there.

•	 When the image provides information that would not 
otherwise be obtained, it must be described with an 
appropriate Alt text.

•	 When the image contains an embedded text, you must 
transcribe the written content in the Alt text.

•	 When an image is complex, such as a graph or a statistic, 
you must present it in the Alt text and provide a separate 
detailed description.

•	 When the image is a link, you must describe its 
destination. This allows links to be interpreted even when 
out of context.

	O Captcha: Distorted images, image puzzles, etc. which are 
used to determine that the user is a human and not a robot. 
You must make the Captcha accessible with an Alt text, 
explaining its purpose and the alternative, non-image-based 

method (e.g. audio). You must also ensure that it can be 
controlled with the keyboard.

	O Image carousel: Be mindful of image descriptions and 
ensure that ‘stop’, ‘start’, ‘fast-forward’ and ‘rewind’ 
controls can be accessed from the keyboard. You must also 
comply with the rest of the accessibility conditions: colour 
contrast, Alt text, well-described links, etc.

	O Media: Ensure that videos have subtitles, audio descriptions 
and transcripts, and that they meet accessibility 
requirements.

Graphs
In T13 - Legibility Guidelines, you’ll find detailed explanations that 
also apply to the website. Remember to consider all pages and not 
just the home page.

	O The size of the text must be flexible. You should be able to 
enlarge it by up to 200% without this altering its structure 
or design. 

	O Adequate contrast: You can check that the page has 
an appropriate contrast by using any of the free tools 
available online.

	O Colour to convey information: Colour should not be the 
only way of conveying information in graphics, buttons, 
links, etc. Instead, you should split graphs into different 
sections, add text to buttons and bold or underline      
links, etc.
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2. How can I make it more Operable?

Second principle: ensuring that the website can be navigated, that 
data can be entered and that the content can be interacted with in 
different ways.

Keyboard
Make sure that the menu is fully accessible with the keyboard, and 
that all actions that can be executed with the mouse can also be 
executed with the keyboard. You must be able to navigate through 
the elements using the “Tab” key and activate the links with the 
“Enter” key or the spacebar.

Time
Some people need more time than others to assimilate or respond 
to content. If you set any time limits, these should be easy to stop, 
increase or delay.

Content visibility
It can be difficult for devices such as screen readers to find or 
locate content. With this in mind, you should:

	O Provide a mechanism that allows the user to skip blocks of 
content that are repeated on each page.

	O Ensure that browsing is easy and user-friendly.

	O Provide mechanisms that allow the user to browse through 
different sections of the page, using headings that appear 
at the beginning of each section. Use a clear structure and 
present information in a logical order, allowing for a better 
understanding of the hierarchy of the contents.

	O Limit the number of links per page, being sure to avoid 
those that don’t contain any content such as “Click here” 
or “Read more”.

	O Make the links stand out visually by underlining them, for 
example.

123



3. How can I make it more Understandable?

Third principle: ensuring that content with good structure, layout 
and wording can be processed and understood.

Easy to read
You must ensure that your editors are familiar with the legibility 
guidelines: align text to the left, avoid excessively long texts, don’t 
abuse capital letters or italics, visually distinguish links, etc.

Page language
Make sure that the primary language is configured for all pages, 
as this is the language that screen readers process the content 
in. You must also indicate any changes in language (e.g. foreign-
language quotations), preferably visually.

Appearance and placement of common elements
All pages have common elements that are repeated, such as 
menus, buttons, footers, etc. You must use standard tags that 
provide semantic information for each of these elements (e.g. html 
tags). For better user experience, these elements should be easily 
identifiable by their appearance and location on the page.

Forms: assistance and error control
While online forms allow procedures to be carried out remotely, 
you should make them accessible by taking into account:

	O Tags: All fields must include a clear and descriptive tag so 
that the user knows what data they need to enter. For screen 
readers, each tag must be explicitly associated with a field.

	O Related information: Grouping related fields makes them 
easier to locate. One such example is address information e.g. 
street, name, number, floor, post code, city, etc.

	O Instructions: you must include instructions on how to fill out 
a form. You should specify the required fields and provide 
details about the format. In addition to the field name, tags 
can also include instructions e.g. “Date (dd/mm/yyyy)”. If the 
instructions are very long, you could add them beneath the 
tag as a supplementary explanation.

	O Validation and error detection: Automatically detect 
whether information is valid and warn the user when errors 
are detected e.g. in the date format. Display the error in the 
appropriate tag for easy access, highlighting it both visually 
and for the screen reader.

	O Notifications: Once the whole form has been filled out, the 
user needs to know whether or not the information has been 
correctly submitted. The notification must be accessible. A 
solitary green traffic light symbol, for example, would not be 
sufficient.

	O Simplicity: the shorter and simpler the form, the better. If the 
list is very long, a person who is blind would need to listen to 
all of the options before deciding on their chosen answer.
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4. How can I make it more Robust?

Fourth principle: ensuring that the content can be reliably 
interpreted by a wide range of technologies.

A robust website is designed and developed in compliance with 
WAI standards and follows best coding practices.

All components used in the construction of a page must follow the 
functions and features set forth in the Accessibility Guidelines. If 
the website is built properly, all browsers, devices and assistive 
technologies will be able to read and navigate all of its content.

The website must be verified with different technologies to make 
sure that it is fully accessible and works properly in different 
environments and platforms.

A robust website facilitates future updates and modifications, 
because a stable and well-organised foundation allows the 
website to grow and evolve.

What is a Website Accessibility Statement?

Under European Union law, you are obliged to prepare, 
periodically update and publish a Website Accessibility Statement 
indicating the compliance of your website(s) and mobile 
application(s) with minimum accessibility requirements.

This statement must be published on the website, and must 
include the following information:

	O Degree of compliance with the applicable regulation.

	O Detail of inaccessible content.

	O Mechanisms for reporting non-compliance with 
accessibility requirements, requesting information or 
making a complaint.

	O Complaint procedure.

Relevant links
	O Website Accessibility Statement models (CA)

	O First steps to making a website accessible (CA)
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T15
How to Publish Accessible 
Content on Social Media 

Texts and structure
You should use short texts with clear and simple language, 

being sure to avoid complex sentences, jargon and idioms. 

This is especially relevant for people who are not fluent in 

the language.

Note that screen readers cannot interpret abbreviations 

(for example, “sq” instead of “square”) or signs (for 

example, “@” instead of “a”).

Use decorative fonts and special characters sparingly, 

since screen readers sometimes struggle to interpret them.

When you make a call to action (CTA), be sure to give it 

meaning. For example, the standard “More information” 

CTA doesn’t tell us anything when it isn’t in context. 

Instead, you could put “Conference programme” or 

“Conference registration form” to explain the content 

of the link. Remember that some networks establish a 

character limit for these links.

Emoticons or emojis?

Emoticons are combinations of keyboard signs or letters 
that represent facial expressions or moods. For example: “:)” 
represents a smiley face. However, these are not considered 
accessible as screen readers cannot interpret them. It would be 
read by a screen reader as “colon, closed bracket”.

Emojis, on the other hand, are small digital images or icons that 
represent an emotion, an object or an idea. Their meaning is 
already tagged for screen readers. While these are accessible, you 
take care when using them:

	O Use them sparingly and don’t repeat them. If you use three 
smiley faces one after the other, they will be read three 
times.

	O It is better to place emojis at the end of the text so as not 
to hinder legibility.

	O Don’t use them instead of words.

	O Choose emojis that have good colour contrast in both light 
mode and dark mode.

	O Consider the context, as emojis can be misinterpreted. 
This is particularly relevant if there are attendees from 
other countries.

	O Pay attention to the colour of the emoji, as skin tones 
are also included in the description that is read aloud by 
screen readers.
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Hashtags
	O Write hashtags in both upper and lower case. By 

capitalising the first letter of each word, it will be easier 
for the user to decipher the hashtag. For example, 
#internationalaccessibilityconference is harder to read 
than #InternationalAccessibilityConference.

	O This system, known as CamelCase, tells screen readers 
that the capital letter marks the beginning of the word.

Images
Studies have found that posts (such as tweets) containing images 
are shared 150% more than posts that don’t contain images. For 
this reason, many social media platforms give their users the 
opportunity to add text to an image. This information will be useful 
for both search engines and screen readers.

	O The explanation of the image in the Alt text helps puts 
everything into context and ensures that nothing goes 
unreferenced.

	O The Alt text must be objective, descriptive and between 
200-250 characters.

	O The description should highlight the image it accompanies, 
referencing the action, movement, relationships, visual 
details and anything else that makes the image stand out.

	O Search engines and screen readers will not be able to read 
text or characters that are included within the image. You 
will need to type out the written content of an image in the 
Alt text description field.

	O You can always add a link to a document or website 
containing additional information or a transcript of the 
content. You could take this approach for tables containing 
data or infographics.

Colour
	O Check colour contrast when sharing graphs, infographics 

or images with text. The contrast between the background 
and the text should be 4.5 to 1.

	O Avoid green-red and blue-yellow colour combinations, as 
these are hard to read.

	O It is difficult to read texts that are overlayed on images. 
Instead, it is recommended to use an opaque or solid 
background.

	O In the case of graphs, use sections rather than colours 
to differentiate the data. To ensure good readability for 
people who are visually-impaired or colour blind, you 
should be able to read it as if it were in black and white.
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Links
	O Use short URLs.

	O Describe the content the link leads to: audio, video,   
photo, etc.

Videos
	O All videos must be uploaded with audio descriptions and 

subtitles or a link to their transcript, ensuring that people 
who need it can access the video’s content in text format.

	O Screen readers use a text-to-speech (TTS) engine that 
translates the text displayed on the screen, including 
image descriptions, into speech. If a video only includes 
visuals and background music, screen readers won’t 
detect them. This will make them inaccessible to people 
who are blind or visually-impaired.

Relevant links to the accessibility resources of 
the most used social media platforms:

	O Instagram

	O X (Twitter)

	O Facebook

	O YouTube

	O LinkedIn
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T16 
Accessible Document 
Guidelines

When creating accessible documents, you will need to focus on 
three main aspects: structure, content and format. By following the 
guidelines or creating templates that incorporate these premises, 
you will standardise accessibility and make the documents more 
accessible for all audiences.

How to create an accessible Word document

When you create a Word document, every element you introduce 
will be tagged in one way or another, even if you don’t see it. If 
you use the tools and features provided by Word properly, you can 
build an accessible document.

	O Metadata

This is the most information contained in the Word 
document. While it might be hard to grasp at first, it is 
quite simple in reality. You just need to go to: File > Info > 
Properties > Advanced properties.

You will see a series of fields for data such as the title, the 
subject, the authorship and other relevant data. Remember 
to add keywords, as this information makes it easier for 
search engines to index.

	O Titles and styles

Create documents with clear heading and title structure 
and logical keyboard navigation without changing the 
order or jumping through the different levels of titles (1, 2, 
3, etc.).

To make the tagging and hierarchy work easier, it is 
recommended to use styles: These are found under Home 
> Styles, where a table will be displayed with different text 
and title styles of different levels, both predefined and 
modifiable. You must apply the appropriate style for each 
part of the document.

By choosing a style, you will include the tags that structure 
the document and allow for keyboard navigation through 
the different titles without having to read the entire 
document, similar to skimming through a contents page.

	O Page language

Make sure that the primary language is configured for 
each page, as this is the language that the screen reader 
will process it in. Review > Language > Language > Set 
proofing language, and choose the one you want.

You must also indicate any changes in language (e.g. 
foreign-language quotations), preferably visually. In this 
case, highlight the word or passage in the text and select 
the new language in lower margin.
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	O Lists

Don’t hyphenate bullet points manually. Remember that 
these must be tagged: Home > Paragraph and then 
choose the most appropriate option from the Bullet Library 
or the Numbering Library: Bulleted list (rounded, squared, 
etc.), Numbered list (numbers, letters, etc.) or Multi-level 
list (hierarchical structure).

	O Tables

Don’t create tables manually using tabs. Rather, go to 
Insert > Table and select the desired number of rows and 
columns.

Tables must be uniform. They must have the same number 
of cells in each row and column. Avoid tables with split 
cells, combined cells or blank rows and columns.

For proper structure, there must be a header or title for the 
content of the columns in the top row. To tag the headers: 
Table design > Show in favourites. Then, with the right 
button: Table properties > Alt text, and add a title and 
description.

	O Graphs

In T13 - Legibility Guidelines, you’ll find explanations about 
colours, contrasts, font size and type, alignment, etc., that 
make documents more accessible.

	O Alt text

As with websites, the images in a document must also 
have an Alt text. In Word, you can do this by right-clicking 
on the image and selecting “View Alt text”. A field will open 
up where you can insert the description. Alternatively, you 
can click “Mark as decorative” if the image is decorative.

	O Links

Remember to describe where the link leads. You can 
do this easily in Word by right-clicking and selecting 
“Edit link”. A new window will open up. At the top, fill in 
the “Text” field with whatever you want to replace the 
meaningless URL address with. For example: “[Conference 
name] accessibility measures”.

	O Checking the document’s accessibility

You can do this easily in Word by going to: File > Info > 
Check for issues > Check accessibility.

Relevant links:
	O How to create accessible Word documents (CA)

	O Microsoft Word accessibility
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How to convert a Word document into an 
accessible PDF

The first step is to make sure that the source document is already 
accessible and well prepared. As explained in the previous 
section, this can be easily done in Word.

Once the initial document has been confirmed as accessible, you’ll 
need to save it in PDF format. File > Save as > Browse.

	O In the “File type” dropdown, select PDF (.pdf).

	O Then, make sure that the “Open the file after publishing” 
box is checked and click “Options”.

	O In the “Include information” section, make sure that all 
the options are checked except for “Word bookmarks”. In 
“PDF options”, all boxes must remain unchecked.

Once accepted, the new PDF document will open up. You will 
find the bookmarks in the left-hand margin, which will give you 
an index of all the headings inserted throughout the document. 
If they’re not all there, it means you didn’t configure it properly. It 
is recommended to check the navigation by skipping through the 
document with the tab key.

How to create an accessible PowerPoint 
presentation

PowerPoint presentations are useful documents, but they pose 
quite a challenge when it comes to accessibility and usability. You 
can ensure that they are accessible by using the tools and features 
provided by PowerPoint.

	O Metadata

As with any other document, it is important to fill in the 
metadata that will facilitate the identification of screen 
readers and the indexing of search engines. You just need 
to go to: File > Info > Properties > Advanced properties.

A series of fields will open up where you can include the 
title, the subject, the authorship, the keywords and any 
other relevant data.

	O Initial design

PowerPoint has a collection of accessible templates that 
you can use. When you enter PowerPoint, go to File > New 
and a search field will appear. Type “accessible” to see all 
of PowerPoint’s accessible templates. Choose one that 
suits you and create the presentation.

	O Slide format

Once you’ve selected the template, follow the default 
format and introduce modifications where necessary. You 
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can also select the predefined slide formats offered by 
PowerPoint by going to Home > New slide. A drop-down 
menu will appear where you can select the best format for 
each slide.

	O Slide design

PowerPoint also allows you to design the page colours, 
font, etc. You’ll find a range of different options under the 
Design tab. Simply by clicking on the options shown in 
the horizontal bar, you’ll see how the slides will appear for 
each option. It is also possible to change the background 
colour and the size of the slide.

	O Font type and size

Remember that sans-serif fonts such as Arial, Verdana and 
Helvetica are the easiest to read.

As your presentation will probably be projected onto a 
large screen, it is recommended to use a font size of no 
smaller than 24.

	O Colour and contrast

Provide an appropriate colour contrast on each of the 
slides.

You mustn’t use colour as the only way to convey content. 
You can check this by switching the slides to black and 
white. This can be done by going to View > Grayscale.

	O Animations and transitions

You should avoid animations and automatic slide 
transitions because:

•	 They can be distracting.

•	 They can make screen readers re-read the slides.

•	 They might be displayed in the wrong order.

•	 They may not give the audience enough time to read the 
content of the slide.

	O Embedded media

Make sure that any videos embedded in your slides have 
audio descriptions, subtitles and accessible controls.

If an audio-only file is embedded, make sure that a 
transcript is included.

	O Views

On the left side of the screen, you’ll usually see thumbnails 
of all of your slides including their design elements.

If you switch to Outline View, you can check the order in 
which the slides will be read by a screen reader as well as 
the title and text of each slide. To switch to this view, go to 
View > Outline View. Note that tables, graphs and images 
will not be displayed in Outline View. Instead, only the titles 
are displayed.
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	O Alt text

Images that provide context must have an Alt text. 
Redundant, decorative images that do not add value to the 
presentation, however, do not require one.

To add, modify or delete Alt text, hover over the image, 
right-click and select “View Alt text”.

	O Links

Remember that the text of a link must clearly describe 
where it leads. It is recommended to make links stand 
out visually. One such example is to underline them. You 
can easily do this in PowerPoint by right-clicking and 
selecting “Edit link”. A new window will open up. At the 
top, you’ll need to fill in the “Text to display” field with the 
description.

	O Checking the PowerPoint’s accessibility
You can check the PowerPoint’s accessibility by going to 
Review > Accessibility > Check accessibility. A report will 
be generated which will tell you how to review and improve 
the presentation’s accessibility.

More information can be found at:
How to create an accessible PowerPoint

How to convert a PowerPoint document into 
an accessible PDF

Once the initial document has been confirmed as accessible, you’ll 
need to save it in PDF format. File > Save as > Browse.

	O In the “File type” dropdown, select PDF (.pdf).

	O Next, press the “More options” button. Make sure that 
both boxes in the “Include non-printing information” 
section are checked. In “PDF options”, all boxes must 
remain unchecked.

	O Select “OK” and save the changes.

All accessibility options applied to the PowerPoint (such as Alt 
text, hypertext, reading order, etc.) will also be saved in the PDF 
file.
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T17 
Table of Appropriate 
Terminology

Inappropriate 
expression

Correct 
expression

Comments

Invalid

Handicapped

Deficient

Hampered

Disabled

Crippled

Special person

Person with different 
abilities

Disabled-access ramp 

Disabled access 

Disabled toilet

Handicapped toilet

Person with 
disability

You can also use:
Person with functional 
diversity

Person with disability

Accessible entrance

Adapted entrance

Accessible toilet 

Adapted toilet

Put the person before 
the disability.

Don’t turn the adjective 
into a noun.

Some people and 
organisations prefer 
the term “functional 
diversity” to the term 
“disability”.

Avoid euphemisms 
and paternalisms.

Avoid using obsolete 
terms.

Inappropriate Correct Comments
expression expression

Deaf-mute Person who is deaf or Some people also 
hearing-impaired accept deaf as a noun.

Physically limited Person with reduced The acronym PRM is 
person mobility (PRM) widely accepted as 

Paralysed, disabled

a noun.

Person with a 
wheelchair or 
Wheelchair user

Autistic Person with ASD 
(Autism Spectrum 
Disorder)

Mentally ill, Person with mental 
oligophrenic disorder or Person 

with mental illness

Mentally handicapped Person with intellectual Avoid using offensive, 
disability obsolete and outdated 

Imbecile, mongo, terms
retard Person with Down 

syndrome

Normal person Person without a There is no such thing 
recognised disability as a normal person. 
(or simply Person) Everyone is different 

and unique in their 
own way.
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For more information: 
Inclusive language guide (CA)

Inappropriate 
expression

Correct 
expression

Comments

Suffers with a disability Has a disability

Has a birth defect Has a congenital 
disability

Confined/relegated to 
a wheelchair Wheelchair user

Avoid emotive 
language.

Sign language Sign language

Braille translation Braille transcription

There is a law that 
recognises sign 
language as such.

Braille is not a 
language, but a 
reading and writing 
system.

Refrain from 
mentioning trademarks.

Sonotone Hearing aid or 
cochlear implant

Sign language 
translator or Sign 
interpreter

Sign language 
interpreter

Dwarf Person with 
achondroplasia or 
Person of short stature

https://llengua.gencat.cat/web/.content/documents/publicacions/publicacions_en_linia/arxius/guia-llenguatge-inclusiu.pdf


Before. When preparing a PowerPoint or 
similar file to project:

	O Use a sans-serif font such as Arial, Verdana or Helvetica.

	O Use a minimum font size of 24.

	O Ensure good contrast between the font and the 
background.

	O Refrain from using paragraphs of text. Instead, prioritise 
short sentences such as headlines or keywords.

	O Don’t overlay text on top of an image.

	O Use bold text, but not block capitals or italics.

	O Use minimal text in graphs, drawings and images.

	O Refrain from using animations and special effects.

	O Remember to include subtitles with all videos.

In T16 - Accessible Document Guidelines, you’ll find a section 
entitled “How to create an accessible PowerPoint presentation” 
which provides a simple breakdown of how to design an 
accessible presentation.

T18 
Recommendations for Speakers 
on Accessible Presentations

During. When delivering a presentation:

	O If there is a sign language interpreter, make sure that they 
are ready and in position before you start speaking.

	O Verbally describe what is projected on the screen. This 
will be appreciated not only by people who are visually-
impaired, but also by those who are not looking at the 
screen at the time or who are too far away to read it clearly. 
All graphic or textual information displayed on the screen 
should be addressed in the speech.

	O Always use the microphone. This is a vital piece of 
equipment for interpreters and users of hearing aids.

	O If you haven’t been introduced before you start to speak, 
introduce yourself to the audience. People who are blind or 
visually-impaired will appreciate this.

	O Always speak facing the audience. People who are deaf 
and read lips will appreciate this.

	O Speak naturally and slowly. Not only will subtitling 
professionals and interpreters appreciate this, but 
everyone in the audience will benefit.
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	O Avoid using acronyms and abbreviations in your speech. 
Instead, use the full name of the things you talk about.

	O Use simple and direct language. This is more effective than 
using long statements filled with subordinate phrases.

	O Give clarifying examples to explain complex concepts.

	O In the Q&A section, remind people to introduce themselves 
before asking a question and make sure they don’t speak 
when they don’t have the microphone. However, remember 
that some people may reject the use of the wireless 
microphone because they are electrosensitive. In these 
cases, repeat the question to the audience before you start 
to answer it.

	O If you ask the audience to raise their hands to show their 
support for a statement or position, verbally report the 
results. For example, “I see that about half the room have 
their hands up”.

T19 
Recommendations for 
Interacting with Persons with 
Disabilities

Interacting with people who have specific needs due to their 
disabilities is not such an easy task.

These guidelines and recommendations are especially important 
for public-facing members of staff, but they are also useful for 
everyone.

The two golden rules:
	O Ask before you help

•	 Don’t prejudge or assume that the person needs help.

•	 Before acting, ask if and how you can help.

•	 Let the person do things at their own pace and do 
everything they can do for themselves.

•	 Don’t decide on their participation in an activity on their 
behalf.

	O Act naturally

•	 Don’t act in a paternalistic or overprotective way.

•	 Speak directly to the person with the disability, not to their 
companion or assistant.

Remember that some attendees will be accompanied by their 
service dog and that they are obliged to carry and present the 
corresponding accreditation when required to do so. They also 
have the right to access all event spaces with their service dog, 
keeping it by their sides at all times.
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When interacting with a Person with 
Reduced Mobility:

	O Check that the circulation spaces are free of obstacles and 
remove any moveable objects from their path.

	O When giving directions, tell the person about the 
distance and conditions of the route. You could offer to 
help, accompany or lend a wheelchair to the person, if 
necessary.

	O If the person uses a wheelchair or is of short stature, find a 
seat so that you can talk to them at their level. Sit in front 
of them, not next to them.

	O Pay attention to their abilities. Despite being a wheelchair 
user, they may still get around relatively easily.

	O Avoid touching or moving the wheelchair and refrain from 
leaning on it or hanging things on it without the user’s 
permission. After all, the chair is part of their personal 
space.

	O When accompanying someone with walking difficulties (or 
someone who relies on crutches, a walking stick, a walking 
frame or a mobility scooter), walk at their pace.

	O Offer to help carry or transport their items or luggage.

When interacting with a person who is deaf:

(The guidelines are valid for interacting with people who are oral 
deaf and those signing through an interpreter)

	O Before you start speaking, get the person’s attention by 
lightly touching them on the arm or shoulder or by making 
a hand gesture.

	O Wait for them to look at you before you start talking to 
them.

	O When talking to them, look them in the eyes and make sure 
that your face is well lit (never backlit).

	O Look at them, not at the sign language interpreter who is 
accompanying and interpreting for them.

	O Speak naturally, vocalising well but without exaggerating. 
Don’t rush, but don’t speak too slowly either.

	O Repeat the message if your interlocutor did not understand 
it. You’ll be able to formulate the message in a different 
way.

	O Don’t pretend that you’ve understood the person who is 
deaf if you haven’t.

	O Remember that facial expressions can be helpful when 
communicating with people who are deaf. If you struggle 
to make yourself understood, you can always opt to write 
the message down.
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When interacting with a person who is blind:
	O The first thing you need to do is identify yourself (your 

name and role). Don’t touch them before you speak to 
them.

	O Speak with a normal tone of voice. Most people who 
are blind can hear perfectly well. When more people are 
involved in the conversation, you may tap them lightly on 
the arm to let them know that you are talking to them.

	O You should look at the blind person and speak to them 
directly, rather than their companion or assistant.

	O Body language (head and hand movements, facial 
expressions, gestures, etc.) only has meaning for those 
who can see.

	O There’s no need to avoid words like “see”, “look”, “vision”, 
etc. Feel free to use these words as you would in your day-
to-day speech.

	O When accompanying a blind person, offer them your arm. 
They will normally grasp it just above the elbow and follow 
you half a step behind.

	O When sitting down, guide their hand to the back of the 
chair and briefly describe the context of where they are 
sitting (“at the end of a long table”, for example).

	O Give clear and precise directions (e.g. “three meters 
ahead”). Words or expressions like “over there” or “a bit 
further” aren’t helpful.

	O If you need to leave the blind person momentarily, you 
must let them know in advance. It is better to give them a 
point of reference (the wall, a bench, etc.).

	O There’s no need to show affection to their service dog. It 
is there to work, so it would be inappropriate to distract it. 
The dog is there to help the blind person. Only they should 
interact with the animal. When walking, position yourself 
on the opposite side of the person to their service dog.

Lastly, remember:

	O Before assuming anything, apply the “three ‘A’s rule”: Ask, 
ask and ask.

	O Acting naturally is essential.

	O Remember that the person always comes before the 
disability (which may be visible or invisible). So, focus on 
the person and not their disability.
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	O

	O

	O

	O

T20 
Event Accessibility Report

	OAs a final step, you should document everything concerning the 
accessibility of the event in a brief report containing:

Name of the conference or event, location and dates.

The references to accessibility published on the 
conference website and the section(s) in which they are 
published. For example, a sentence or paragraph from the 
Statement of Commitment contained in the “About the 
event” or “Mission and values” sections; the questionnaire 
in the registration form; FAQs, etc.

The service providers (transport, catering, parallel 
activities, etc.) and their strong points in terms of 
accessibility. For example: “[Bus company name] has 
[number] adapted vehicles, and the drivers are well aware 
of what they need to do to accommodate passengers in 
wheelchairs.”

The specific accessibility resources that have been 
implemented (subtitling, induction loop, audio description, 
materials printed in alternative formats, etc.) and the 
providers of these services. For example: “The induction 
loop wasn’t working, but [Company name]’s sound 
technician was able to fix it quickly.”

External feedback from participants and speakers, with 
a survey summary and comments or suggestions for 
improvement.

An internal self-evaluation carried out by the organising 
committee, including an identification of good practices 
and points to improve.

	O Corrective actions and points of improvement that should 
be taken into account in the future.

You must add the following as annexes to this report:

	O T4: Venue Assessment Checklist.

	O T5: Accessible Accommodation Assessment Checklist

This report, produced by the access officer, will help to leave a 
legacy and set the minimum standards for organising accessible 
events in the future.
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